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1.0 Overview 
This tutorial is divided into three major sections: 

1) Viewing a Map 
2) Create Your Own Map 
3) Getting Information In and Out 

 
Beta Related Issues 
WorldMap is still in Beta so we are working things out in several areas including: interface design, 
functionality, bug fixing, and handling high load conditions.  
 
WorldMap has been tested more thoroughly on Firefox and Chrome than on Internet Explorer.  There are 
known problems with Internet Explorer 6. 
 
There are areas of functionality that require you leave the map page.  When that happens, you will be asked 
whether you want to navigate away from the page.  Click cancel, then save your map, then proceed.  
 
When you are away from the map page you have saved you can use the back button to get back to it.   
 
Help 
WorldMap help is available here: worldmap@harvard.edu 
 
Open System Access 
The system is currently open to anyone in the world to use and is hosted by Harvard on the Amazon cloud.  
We are allowing anyone to upload pretty large files to the system (up to 100 meg).  The combination of 
these factors means that the system could be slow at times. 
 
Open Source 
The platform is Open Source and can be deployed on Linux or Windows environments.  WorldMap 
is currently being developed and deployed on Ubuntu Linux.  Because it is Open Source, all code in 
the system can be examined and improved on by others.  Source code for WorldMap is available at:  
https://github.com/cga-harvard/cga-worldmap.  
 
1.1 Download Materials 
You can download tutorial materials from http://bit.ly/oIg4iL   
 (http://cga-5.hmdc.harvard.edu/data/workshop/July_2011_Training.zip).   
Unzip this to your desktop.  You should now have a folder on your desktop called 
July_2011_WorldMap_Training.  In this folder is this presentation as well as some sample datasets.  
 
1.2 Terminology 
Layers 
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In WorldMap you can upload map data (currently Shapefiles or GeoTIFFs) to the WorldMap 
system. Each map data file you upload is called a “Layer” in WorldMap.  You can control access to 
your layers by setting permissions. 
 
Maps 
WorldMap allows you to organize your Layers and other people’s Layers together into collections, 
which you can configure in various ways and save.  These collections are called “Maps” in 
WorldMap.  You can control permissions in WorldMap at both the Layer and the Map level.   
 
2.0 Viewing a Map 
WorldMap supports two basic uses of the system: 1) viewing (and if you are allowed, editing of 
Maps others have created, and 2) creating your own maps.  We will start with viewing maps others 
have created. 
 
2.1 Find a Map to View 
To start searching existing maps, click “Viewing a Map” on the front page.  Here you will see a list 
of maps others have created, listed in the order in which they were created.  Use the search box to 
find things you want.  
 
Next to the name is the name of the person who created it so you can contact them.  WorldMap is 
about encouraging collaborations between people with common interests. 
 
Click on Lex’s profile.  Lex is building a map called ChinaMap.  Lex has added a custom banner, 
which you can do too,  just email it to us.  Later you will be able to add it yourself. 
 
Let’s take a look at AfricaMap Map by Suzanne Blier. 
 
2.2 Note on Permissions 
Without being registered you can make changes to this Map but you can’t save the changes without 
permission to edit the map.  You cannot have permission if you are not registered.  If you had 
permission you would see a “Share Map” link in the upper right corner.  In part two you will create 
your own map, to which you will have full permissions. 
 
Currently this map is set to be viewable by anyone in the world. 
 
2.3 Choice of Basemaps 
A number of preset basemap layers are available, including Google Satellite, Hybrid, Roads, 
Physical, and Open Street Maps.  Other commercial and non commercial base maps will be added 
soon. 
 
2.4 Ways to Zoom 
There are several ways you can zoom (change scales) in WorldMap:  

• Map navigation tools include the standard zoom bar and map drag.   
• Roll your mouse wheel. 
• Choose a scale from the scale bar readout.   
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• Zoom and pan simultaneously by defining a box on the map (shift-drag box) which upon 
release zooms you to the area you defined with the box.   

• You can right-click on a layer name and select “Zoom to Layer Extent” to zoom to that layer. 
 
Let’s use the shift-drag box approach as I think it is the most powerful once you get the hang of it. 
 
2.5 Legend, Scale Bar 
WorldMap generates legends automatically based on the SLD (Styled Layer Descriptor) 
symbolization.  Legends for any vector layers being displayed are in the Legend tab next to the Data 
tab at the upper left.  The scale bar changes with zoom level and the exact scale ratio is displayed.   
 
2.6 Layer on/off, Layer Order, Transparency 
You can turn layers on and off, move them around to control what is displaying on top of what in the 
map.  You can also change transparency of any layer by right clicking and going to Layer Properties. 
 
2.7 Layer Renaming, Category renaming 
You can rename layers by right-clicking a layer, selecting “Layer Properties”, then “About”.  You 
can rename a category by right-clicking it and selecting “Rename Category”. 
 
2.8 Map Click for Details 
Now let’s click on the map and return attributes, by “drilling” down through multiple layers and 
displaying the attributes on the right. 
 
WorldMap will return attributes for as many (vector) layers as you have turned on.  The layers will 
be listed at the upper right and the individual records will be listed in the panel below.  You can 
select records grouped by layer in the upper panel and see the record highlighted on the map and 
attributes displayed in the panel below. 
 
2.9 Add a Layer from WorldMap 
Without permissions you will be able to add layers from WorldMap as well as add remote web 
services just for the session, but you will not be able to save your additions.   
 
Let’s click “Add Layers” and notice there are three tabs for adding a layer: “WorldMap Data” (for 
Layers which are already in WorldMap), “External Data” (for Layers which can be accessed via a 
web service URL), and “Upload Layer” (for Layers you would like to upload from your own hard 
drive). 
 
Select the “WorldMap Data” tab.  Now type “gaul” in the Search box and click “Search”.    
 
Select “GAUL Level 1” by toggling the check box next to it, then clicking “Add Selected Layers” at 
the bottom. 
 
2.10 Layer Order 
Layers which are above others in the layer panel display on the map on top of those which are 
below.  Display order can be changed by dragging and dropping layers up or down, and the names of 
folders and layers can be changed.   
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The category, a required part of the metadata, provides the default category for a layer added to a 
map. 
 
Let’s make “Language Families Felix” non-transparent.  Now we can’t see the GAUL layer.  Now 
let’s drag the GAUL layer so that it is above the Language Families layer and we can now see it. 
 
 
3.0 Exercises for “Viewing a Map” Section 

1) Explore the list of available maps (click “Viewing a map”) on the main page.  If you want a 
map with a lot to explore, try ChinaMap or AfricaMap. 

2) Use the search box and map to refine your search. 
3) Open a map of interest. 
4) Try each of the 5 different methods for zooming 
5) Notice how the legend and scale bars change as you zoom 
6) Turn display for a layer on and off 
7) Right click on a layer to explore the options 
8) Drag a layer that is turned on but not visible to be above a layer that is turned on and visible 
9) Use transparency control to allow you to see a layer displayed even though it is below 

another layer 
10) Rename a layer 
11) Rename a category 
12) Click on the map and return database information for the layer displayed. (Some image or 

raster layers will not return information.  The layers which have a checkerboard pattern next 
to them are image layers and will not return information when you click on them.) 

 
Optional Challenge Exercise 

1) Click on “Add Layers” and search for a layer using a combination of a keyword and the map. 
2) Once you find a layer of interest, turn it on by clicking the check box next to it and clicking 

“Add Selected Layers” at the bottom.   
3) Close the Add Layers window.  You may need to zoom out or right click on the layer you 

added and click “Zoom to Layer Extent” to see it.   To see it you may also need to drag the 
layer to be above another layer you have turned on. 

 
4.0 Create Your Own Map 
4.1 Registering 
To register click “Sign In” on the front page, then click “Register”.  Fill out your username, email 
address, password, and if you are Harvard check that. If so you will be sent to a page to verify your 
Harvard ID.  (There is no difference in functionality between Harvard and non-Harvard.  We are 
starting to allow access control by group and Harvard is the first group we have enabled.)  You will 
then receive an email with a validation link that you must click to be registered.  Now you have an 
account and a profile and you can log in on the front page. 
 
NOTE: Unregistered users can view all public content on the system and can make temporary 
changes to Maps created by others.  Registered users can create their own Maps, upload materials, 



WorldMap Training   July, 2011  Page 6  

change symbolization, and save changes.  In addition registered users can control access to layers 
they own and can access any private content that has been made accessible to them by others.   
 
4.2 Filling in Your Profile 
Profiles allow people to find out about other users of the system.  A user’s profile name is associated 
with any layer or map they create. Once you are logged in you can go into your profile and add 
information about yourself.  As you add materials to WorldMap, those materials will be listed here. 
 
NOTE: The user profile contains at a minimum the user’s name and email address.  Other optional 
items include organization, position, phone, fax, address, city, state, zip, country.   
 
4.3 Create a Map 
Click “Creating a Map” link at the top of the page.  A blank map template displaying the Google 
Terrain base map appears.  Zoom to some part of the world and start to build your map.  Zoom using 
the shift-drag approach to Sierra Leone at scale level 10, about 1:500,000 scale. 
 
4.4 Change Base Map 
Let’s change our base map from Google Terrain to Google Hybrid 
 
4.5 Saving your Map 
Now let’s save our map.  Click save and here we have several items we can define as we save the 
map.     

• Name - This is the name as it will show up in the map search tool.  The name is also 
displayed on the header at the top of the page. 

• URL – You decide what is displayed at the end of the URL.  Example:  
http://worldmap.harvard.edu/alpha/maps/my_test   

• Abstract – A short description of the Map.  This and the title are used by map search. 
• Keywords – Words that are used to filter feeds Picasa, YouTube, and HGL.  Separate 

keywords with a space.  A space acts as an “or” operator to make your filter more general. 
• Splash page – Formatted text which appears in an introduction box when the site is first 

opened by a user.  This content also appears when you click on the “About” link at the upper 
left. 

• Banner (coming soon) - Soon it will be possible to upload a banner to further customize your 
Map.  Until then email us with your banner attached and the site you want it added to and we 
will add it. 

 
4.6 Permissions, Map Name, Profile 
Once you have created and saved a map, you can control who else in the world can see it.  Click on 
“Share Map” link at the upper right and you can make your map private or share with just a couple 
people or open it to the world.  If you want, you can choose to only allow certain people to make 
changes to your map. 
 
NOTE: You can also control permissions on layers in your Map.  If you want, you can create a map 
which is public and includes some public and some private layers. 
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Once you have created a Map or loaded new data to WorldMap, a link to that material shows up in 
your profile where others can see what you have created.  If a map or layer is not public for viewing, 
the name of it will still show up here.   
 
4.7 Changing Styles (PLEASE DON’T FOLLOW) 
NOTE: Users can modify the way a vector (point, line, or area) map is displayed, and control the 
color of lines or area fills as well as labels.  Users can also use rules to support complex 
symbolization schemes based on database and scale conditions. WorldMap uses an open format for 
symbolization called SLD (Styled Layer Descriptor).  SLDs created can be uploaded to WordMap 
and used to symbolize a given layer. 
 
In addition to controlled data sharing, one of the key benefits of WorldMap is cartographic 
expressiveness.  The Style tool allows you to create SLDs or Styled Layer Descriptors which are 
XML documents that define the way a layer looks. 
 
It is possible to edit map styles and create new styles in WorldMap.  In addition you can use desktop 
tools such as ArcGIS to more easily create complex styles, and this is discussed later.  Styles are 
created using one or more rules.  Each rule can have several parts, including a label, coloring, scale 
dependency, and one or more database conditions. 
 
At the top of the tool you can choose between existing styles for a given layer, copy an existing 
style, or edit an existing style, or create a new style from scratch. 
 
Let’s start by editing a rule from the currently chosen style.  Select the rule and click Edit.  There are 
three tabs containing options for defining the rule you are editing. Aspects of a rule that you set in 
the various tabs are cumulative for a rule so for example you create a rule by setting the color in the 
Basic tab and then a database condition to control when that color is displayed in the Advanced tab. 
 
 In the Basic tab it is possible to: 

• change the name of the style 
• change its fill and outline color (if it is a polygon) 
• control opacity of line or fill 
• control line width and line style 

 
In the Labels tab it is possible to: 

• Select a field to use as content for your labels 
• Choose a font type and size and style for the Label 
• Choose the color for the Label as well as the opacity 
• Choose a halo (background color) for the Label, including its color, size, and opacity 

 
In the Advanced tab it is possible to: 

• Limit the display of whatever you have defined in Basic and Label tabs in terms of maximum 
display scale and minimum display scale. 

• Limit the display of whatever you have defined in Basic and Label in terms of one or more 
database conditions. It is also possible to set multiple groups of conditions. 
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I will demonstrate how: 
• Polygon styles can be changed.  
• To modify simple style in terms of fill, outline, opacity. 
• To set label and scale dependency (LandType) 
• To set a database condition for a rule and combine it with another database rule.  (Suitability 

> 50). 
• Show how to create a new style from scratch or duplicate one. 
 

4.8 Creating Styles with Desktop Software  
There are various software packages for creating styles for your maps. This section summarizes two 
different software tools, highlighting pros & cons for each technology used for creating SLD styles 
for your maps. First is a tool which runs in ArcGIS 9.3 and ArcGIS 10 called ArcMap2SLD. Second 
is a plugin which runs in QGIS, an open source software called Quantum GIS available for 
download for free. 

Using ArcMap2SLD in ArcGIS 10 
This approach allows you to take advantage of much of the symbolization power of ArcGIS and 
apply it to WorldMap.  The 9.3 version is here: http://wald.intevation.org/projects/arcmap2sld/. The 
ArcGIS 10 version is in the packet of materials you downloaded and will soon be included on this 
site.  
ArcMap2SLD version 1.3 runs on ArcGIS 10 on 32 bit operating systems only at this point.  Here 
are instructions for using it.   
 
First open ArcGIS 10 and load the layers you want to symbolize and add to WorldMap.  Once you 
have them the way you want them to look, start ArcGIS2SLD.  (Currently this tool works best with 
capturing the colors of point, line, and polygons layers.)   

 
Define a path and name for the SLD file you want to create. 
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IMPORTANT:  Uncheck “Include Layer Names” under Extras. 

 
If you would like to include only selected layers (this is not the same as turned-on layers) to be 
exported from your ArcGIS map to SLD, check “Selected Layers”.  If you have multiple layers in 
the map you are exporting, you will need to also check “In Separate Files”.   The tool will then 
create separate SLD files, one for each layer in your ArcGIS map.  To load these to WorldMap you 
will need one SLD with each corresponding shapefile you wish to symbolize.  Click the blue SLD 
button at the bottom left to create your SLD files.   
Note on Multiple SLDs for a Single Shape File 
If you want to create multiple SLDs for a single shapefile, create the SLDs then contact us at 
worldmap@harvard.edu.  If you email us the SLDs and tell us which layer you would like them 
associated with we can make the association for you.  There is currently no way for end-users to 
upload multiple SLDs for a given shape file. 
 
Pros & Cons for Using ArcMap2SLD in ArcGIS 10 method 

  Pros:  
 ArcGIS 10 is the most commonly used commercial software package and most 

people are familiar with it. 
 Can create multiple SLDs into separate files in one shot using Arc2SLD tool, great 

for large number of layers. 
 No additional changes in the SLD style code required just make sure to uncheck 

“Include Layer Names” option. 
  Cons:  
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 Arc2SLD tool does not run on 64 bit OS, even in compatibility mode (tested on 
various PCs), works fine on 32 bit. 

 Does not recognize <all other values> category/class in the layer properties -> 
symbology tab if you want to classify by “unique values” in ArcMap 10. Simple fix: 
add all unique categories, and then group the selected ones as “all other values”. For 
example, imagine you have 2 categories: “missing values” & “blank” that you want to 
assign one color as “missing data”. Grouping those 2 categories into one makes it 
work for SLDs. 

 Does not work with Layer Properties -> Definition Query in ArcMap 10. For 
example, if you want to display only selected records from the data, you should use 
the symbology tab instead, or alternatively create a new shapefile with the selected 
records only. 

 Does not work for layers grouped together. Simple fix: ungroup the layers when 
creating multiple SLDs. 

 Does not recognize Display -> Transparency in ArcMap 10. For example, if you set 
the transparency layer to 50%, the SLD will take it as 100% color. In other words, 
when you upload the layer to WorldMap you will not see it transparent, instead you 
will see it as a lighter shade of the solid color you chose. 

 Does not work with charts, such as pie chart or bar chart symbology. 
 

Using “Save as SLD” plugin in QGIS 1.7 
QGIS is an open source desktop GIS software application, available for free download at 
http://www.qgis.org/. Use QGIS 1.7 desktop application to create your maps and symbolize your 
layers, and “Save as SLD” plugin to export them to SLD styles.  
 
To install “Save as SLD” plugin in QGIS, go to Plugins -> Fetch Python Plugins -> Repositories tab. 
 

 
IMPORTANT: Click on “Add 3rd party repositories” and click OK to the message prompt. 
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Then click on “Plugins” tab and filter for "SLD", select “Save as SLD” and install plugin. 
 

 
“Save as SLD” should then appear under the Plugin dropdown menu. 
 

 
After styling your layer, simply click on Save Style as SLD and specify the path for the layer style. 
 
Pros & Cons for Using “Save as SLD” plugin in QGIS 1.7 method 

  Pros: 
 QGIS is an open source desktop GIS application, available for free download. 
 QGIS is easy to use and learn. 
 Runs on various OS, including Windows 7 64 bit OS. 
 SLD plugin is easy to install. 
 No additional changes in the SLD style code are required. 

  Cons: 
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 No option to export multiple SLDs, export one layer at a time; hence, not good if you 
have large number of layers. 

 No option for styling with proportional symbols by size. For example, styling layers 
with point feature data to represent various sizes in points based on the quantity they 
represent is not an option in QGIS styles. 

 Does not work with charts, such as pie charts or bar charts. 
 

4.9 How to Use Multiple Styles 
NOTE: WorldMap supports the association of multiple styles with a single data layer. The user can 
choose the default style within the “Share Layer” page. After a layer is added to a map, the style can 
be changed from the default style to another one.  It is possible to load the same layer to a map 
several times and have it displayed each time with a different style. 
 
Currently users can upload one style at a time along with a layer. There is no way yet for users to 
associate more than one style with a layer, however a WorldMap administrator can do that, and if 
you need to do that let us know. 
 
I will demonstrate using the Chicago census block layer how one can choose between various Styles 
that have been associated with a Layer. 
 
I will click “Add Layers” and search for “census”.  I will add “Chicago Census Blocks” to my Map. 
Next I will right-click on the layer, select the “Layer Properties” then the “Styles” tab, and look at 
the styles available. The style that is currently selected is the default (Percent White), but there are 
other styles here that can also be chosen.  
 
It is possible to have the same layer on your map multiple times with different styles and different 
names.  I will rename this Layer to “Percent White” by right-clicking on the layer and going to 
“About” tab, then changing the “Title”. One must click somewhere in the tool to make the change 
active. You should see the name of your Layer change.   
 
Now I will load the same layer again and change the style to “Percent Black” and change the name 
of the Layer to “Percent Black”. 
 
To change the default style I will first save my map, then go to the “About” tab and click “Share 
Layer”.  Now I will toggle a new default SLD, “Percent Black”.  Now I can go back to my map by 
clicking the name of the map up at the top of the page, or clicking the back button.  Now when 
anyone loads “Chicago Census Blocks” layer to the map it will first display using the (now default) 
Percent Black style rather than the Percent White style. 
 
4.10 Upload Shapefile with Associated Style (DON’T FOLLOW) 
Now I will upload a shapefile to WorldMap.  I will click “Add Layer” and select “Upload Layer”.  
Now I will give my layer a name.  I will call this layer “Suitability_BGL7_test”.   
 
I’m using my initials and a number to make sure it is unique and that I can remember it. I’m calling 
it “suitability” as a descriptor.  I’m adding test so this and the ones you will be creating shortly can 
be removed.   
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Now I will choose the required parts of the shapefile starting with the “.shp” part and continuing 
with .dbf, .shx, and .prj parts.  You can optionally include an SLD for styling.  You can also 
optionally define the text encoding if you know what it is, though for this layer the default is 
appropriate, Latin 1.  There is a description of encoding in the glossary.  If you knew you had 
Chinese or Arabic characters in your file, you might choose UTF8 instead or perhaps GBK. 
 
When you come to the “Upload Layer” page you will see these areas (* items are required). 
 
*Title:  Give your layer a title. 
 
*Data:  Choose a Shapefile (.shp part) or zip compressed shapefile or GeoTIFF as your data to load.  
If you use a zip compressed shapefile, be sure the zip file contains the .shp, dbf, shx, and prj parts of 
the shapefile.   
 
HINT: You will increase your chances of a successful upload by having your shapefile or GeoTIFF 
file be in the “plain vanilla” projection space, Geographic WGS 84, also known as EPSG:4326.  To 
know whether your shapefile is in this space, the contents of your .prj file will look like this in a text 
editor: 
 
GEOGCS["GCS_WGS_1984",DATUM["D_WGS_1984",SPHEROID["WGS_1984",6378137.0,298.257223563]],PRI
MEM["Greenwich",0.0],UNIT["Degree",0.0174532925199433]] 
 
You may not have a .prj file for your GeoTIFF as it is not needed since the projection information 
for a GeoTIFF is stored in the header of the GeoTIFF. 
 
If your .prj file does not look like this, the upload may still work fine.  If it doesn’t, the most likely 
culprit is the projection space.  The best way to fix that is to use an application like ArcGIS or QGIS 
and reproject your file to Geographic WGS 84.  This can be done for shapefiles or GeoTIFF files.  
Check with us on how to do a reprojection if you need help. 
 
SLD:  Optionally provide an SLD.  This is an XML document that you would have created using the 
ArcMap2SLD tool. 
 
*Abstract:  Provide a description of your data. More information is better.  At the very least when 
you add real data, please include a brief description of the data, who created it, for what purpose, and 
when.  Please also include source materials used to create the data layer.  This information is 
important both for you to remember what the data is about, and to allow someone else a chance to 
benefit from your work (assuming you want to make the data available for others to use at some 
point). 
 
Permissions:  Default permissions are set such that the world can view it but only you can change it.  
Add individual users to define who can edit (modify the style), or manage (delete layer, change 
permission settings).   
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If you select a GeoTIFF file for the Data item above, the view will remain the same.  If you choose a 
shapefile, (the part of the shapefile with the “.shp” ending), the view will change to handle the 
additional parts of the shapefile as shown below as well as an optional encoding selection:   
 
*Data:  Choose the .shp portion of the shapefile 
*DBF:  Choose the .dbf portion of the shapefile 
*SHX:  Choose the .shx portion of the shapefile 
*PRJ:  Choose the .prj portion of the shapefile 
Encoding:  Choose an optional encoding.  The default is Latin1. 
 
NOTE: A number of character encodings are supported including UTF8/Unicode, GBK, and 
Latin1/ISO-8859-1 to Latin15/ISO-8859-15, and in addition various Windows encodings.  Specific 
encodings can be set when a layer is being uploaded.  The default encoding is Latin1.  
 
Click “Upload” and once uploaded you will be presented with a metadata form (see below).   
 
4.11 Metadata 
NOTE: Users uploading new layers are prompted to fill in optional and required descriptive 
information about the layer.  Required items include: Title, Abstract, Keyword, thematic category 
(ISO 19115 format).  Eventually Author, Source, and Date will be included as options in the 
metadata editor.  
 
Once the file has been uploaded, the only additional required items are Keyword and Category, 
though there are useful metadata fields here which we strongly encourage you to make use of.  
Starred items are required. 
 
*Title  Provide a title for your dataset.  We recommend using the following naming convention: 
 
<geography - continent, country, state, or city>_<what it is>_<date data represents>_<optional 
version>_<optional tmp if it is for testing purposes and can be removed after a week>  
 
Example:  
africa_ethnographic_1959_2_tmp 
 
Date  This date is filled in automatically with the date of upload, but can be changed. 
 
Date Type (creation/publication/revision) Choose type of date you want to describe. The default 
type is “creation”. 
 
Edition  Use this field to describe the edition. 
 
Abstract  Give an overview of the dataset. What does the data represent? Who created it and when? 
What sources were used?  
 
Purpose  Describe briefly how the data can be used. 
 



WorldMap Training   July, 2011  Page 15  

Maintenance Frequency  How often is the data updated? 
 
*Keywords  Add keywords that will be useful handles others can use to find the dataset.  Separate 
keywords with a space. 
 
Keywords Region (under construction) Select a major region of the world.  Other regions in 
addition to countries will be added. 
 
Constraints Use  What are the rules governing the use of this data?  We encourage users to adopt an 
appropriate Creative Commons (http://creativecommons.org/) license to define the type of 
attribution they require, whether the data can be used commercially, and under what conditions 
modifications of the material can be redistributed.  
 
For example if you would like to restrict use of your data to non-commercial uses and don’t mind 
others using as long as they provide proper attribution and don’t mind others modifying your work 
and redistributing modifications as long as this license is attached, we would suggest a non-
commercial share alike license such as this one: http://creativecommons.org/licenses/by-nc-sa/3.0/.  
Or feel free to create your own license.  If you do, include the URL to the license here. 
 
Constraints Other  Include any additional constraints. 
 
Spatial Representation Type  

• grid – raster dataset such as georeferenced satellite image or scanned georeferenced map in 
GeoTIFF format. 

• steroModel – currently not supported unless stored in a GeoTIFF or Shapefile format 
• textTable - currently not supported unless stored in a GeoTIFF or Shapefile format 
• tin - currently not supported unless stored in a GeoTIFF or Shapefile format 
• vector – point, line, or polygon dataset in ESRI Shapefile format. 

 
Language  Please choose the language closest to the language used in the attribute table if the 
dataset is a Shapefile and for the language used on the map if the dataset is a GeoTIFF. 
 
Temporal Extent Start Date  (Under construction) Use only a start date if a date range does not 
make sense for your data.  This date should describe the “temporal footprint” of the data.  What time 
period does it describe?  This is generally not the date the data was published. 
 
Temporal Extent End  (Under construction) Use an end date if the data in your layer is best 
presented by a date range. 
 
Geographic Bounding Box  This describes the theoretical box necessary to enclose the data 
geographically and is automatically calculated by the system.  It can also be modified here.  The 
projection system used to define the bounding box is also defined here. 
 
Supplemental Information   Additional information about your data. 
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Distribution URL  This URL is calculated by the system.  This URL displays this data layer along 
with information about it and is a possible form of citation. 
 
Distribution Description  (Under construction) 
 
Data Quality Statement  Add any information you have describing data quality. 
 
Point of Contact  Person who  should be contacted with questions about the data. 
 
Metadata Author  Name of the person who created the metadata.  
 
*Category  These are ISO 19115 categories and help make it possible for queries from other system 
to return meaningful results. 
 
Attributes  For Shapefile datasets an attribute control table is automatically generated with the 
following columns: 

• Attribute   Lists the fields in the database.   
• Display Title  Is used to control how the fields are displayed when a user clicks on the layer 

on the map and returns attribute information in the panel to the right.   
• Display Order  This is the order in which the attribute information is listed when returned in 

the panel to the right after a click on a map.  NOTE:  The field which is displayed first is 
used in the summary table in the upper part of the panel to the right.  It is best to designate a 
field to be first which provides meaningful information at the record level. 

• Searchable?  This toggle determines whether the field will be searchable from the text 
search box to the lower left of the map. 

•  
4.12 Troubleshooting Shapefile Uploading 
If the layer does not upload there are several possible reasons why: 

1) The projection is not being read properly.  If the layer is not already in Geographic WGS 84 
space, also known as EPSG 4326, project the shapefile to that space and try again. 

2) The SLD file is not correct.  Check and make sure that you have made the required changes 
to the file as defined above.   

3) Check to see that the XML is valid: http://validator.w3.org/#validate_by_input   
4) Check to see that the SLD file was created for this shapefile and not another shapefile.  The 

fields described in the SLD should match the fields in the shapefile. 
 
If all else fails, project your file to Geographic WGS 84 (we can help) and don’t include any SLD. 
 
4.13 Upload GeoTIFF 
Raster files are images and can be satellite imagery or scanned maps which have been 
georeferenced.  GeoTIFF files are rasters and have all the necessary information for display and 
georeferencing in one file. 
 
Click “Add Layers” and “Upload Data”.  Now give it a title “elevation_BGL_7158”.  Choose the 
elevation.tif file to upload.   Provide abstract information and click “Upload”.  Fill in a keyword and 
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category.  Notice that there are no fields for raster layers.  This means there will not be information 
returned when the layer is clicked on, unlike shapefiles which contain attributes. 
 
Raster (GeoTIFF) images do not have the same type of styling options as vector (shapefile) layers 
do.  
 
4.14 Permissions 
Users can control whether others can see and/or modify the layers they load to their Map. Layer 
permissions are added using email addresses, as with a Google Doc.  Layer permissions can be set at 
the time of upload and can be modified as needed later.  Currently the only group authentication 
control is for Harvard and uses Pin authentication via an Isites page.   
 
WARNING: Currently any uploaded layer which can be viewed by the public is also 
technically downloadable even though it may appear not to be.  There do exist some custom 
layers in WorldMap which reside on a separate server and can be viewed but not downloaded, but 
the ability to make layers viewable but truly not downloadable is not yet enabled in the WorldMap 
interface. 
 
 
5.0 Exercises for “Creating Your Own Map” Section 

1) Register on WorldMap and Sign in 
2) View and update your profile as needed 
3) Zoom to an area of interest 
4) Change the base map 
5) Save your map with a name you will remember.  NOTE: Please use the name formatting 

<subject>_<initials>_temp. 
6) Add a WorldMap layer using the “Add Layers” button 
7) Upload a shapefile “workshop_suitability.shp” with SLD “suitability_atlas.sld”.  NOTE: 

Please use the name formatting for the title <subject>_<initials>_temp. 
8) Add the minimum metadata – Title, Abstract, Keyword, Category.  Make “Landsystem” #1 

and “Soilasstex” #2.   
9) View your uploaded layer on the map. 
10) Save your map. 
11) Click on the layer you added and see the “Landsystem” attribute at the top of the list. 
12) Make your new layer the only one turned on 
13) Search using the text box at the lower left for “moyamba”.  Yellow areas should highlight. 
14) Save your map 
15) Upload GeoTIFF “elevation.tif”.  NOTE: Use the name formatting 

<subject>_<initials>_test. 
16) Add the minimum metadata – Title, Abstract, Keyword, Category.  
17) View your elevation data on the map 
18) Save your map. 

 
Optional Challenge Exercise 

1) Find a partner to work with nearby. 
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2) Have your partner view your map (email them the URL) and try to make a change to your 
map and save it (could change the base map).  (They should not be able to.) 

3) Now each of you in your own maps, right click on one of the layers you uploaded.  Go to 
Layer Properties -> About -> Share Layer. 

4) In the lower right corner are Permission controls for your layer.  Change permissions for 
“Who can view or Download this” from “anyone” to “Only users who can edit”.  Add your 
partner email as one who can manage and edit.  

5) Now view and try and change your partner’s map (add a layer or change the base map).   
(Now it should be possible.)  

 
 

6.0 Getting information In and Out 
6.1 Adding Remote WMS Layer 
WorldMap supports the addition of a layer to a map via a “web map service” or WMS.  Given a 
WMS URL to remote server X, WorldMap will then request a list of all the Layers on that remote 
server, and display the list in WorldMap to select from and add to the Map.   
 
Let’s look at how a remote WMS layer can be added.   
 
Copy the World Health Organization URL below:  
http://Maps.who.int/tools/geoserver/wfs?request=GetCapabilities?SERVICE=WMS&REQUEST=G
etCapabilities 
 
Click “Add Layers and go to the “External Data” tab and click “Add WMS Server”.   
 
Paste the URL into the form and make sure there are no spaces at the end of the URL.  Click “Add 
Server”. 
 
After a moment, WorldMap should display a list of Layers from the WHO server. 
 
Click on Title list to sort.  Click on “Global Health Facilities” and at the bottom click “Add Layers”. 
Close the “Add Layers” window. 
Save your map. 
 
Now add another WMS server: 
http://worldmap.harvard.edu/africamap/tilecache/tiles.py/1.0.0/ 
 
Click on the Title list to sort.  Click on “Landscan” Layer and then “Add Layers”. 
Save your map.   
 
Drag Landscan so that it is below “Ethnicity Felix” layer and displays underneath them. 
Save your map again. 
 
6.2 Bookmark and Embed Your Map in Another Web Page 
In addition to being able to save changes to your map, it is also possible to save sub-views of your 
map using the “Link” button.  These views can take the form of a bookmark URL or the form of an 
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embeddable code snippet.  The code snippet can be pasted into any web page to provide a live view 
of your map within a blog or any web page. 
 
Create a view that you like and want to show to someone else.  Then click the “Link” button at the 
upper left. 
 
Now you have a bookmark URL for the view as well as an embed tag that you can paste into a blog 
or an HTML page. 
 
Open a blog or page if you have one.  If you don’t have one and would like to try this, go to 
http://blogspot.com and create a blog. 
 
I will open a test blog I have called http://unequaltran.blogspot.com.  I will then paste the snippet 
into the blog and save it.  Now I will view it.  See that panning and zooming is supported.  
 
You can change the size of the embedded map by using the pulldown to change the height and width 
of the embedded map (measured in pixels), or by editing the height and width parameters in the code 
snippet manually.  
 
6.3 Feeds 
Find the little “More” box at the upper right.   
 
These items are feeds which are a form of map service similar to the WMS map services you loaded 
earlier through the “Add Layers” button..  These feeds need to be accompanied by a filter word 
which (currently) is stored in the form which appears when you click the “Save” button. 
 
Click “Save” and type “Freetown” in the keywords section.   
 
Now turn on Picasa.  All of Picasa’s photos which are georeferenced and which have the keyword 
“Freetown” are displayed on the map.   
 
This also works for YouTube for videos and for maps stored in the Harvard Geospatial Library.   
 
For Picasa and YouTube, keep zooming in on an area of interest if you see some content there.  
Generally more and more content will appear as you get closer to the ground. 
 
NOTE: This approach means if you have image or video content you want to have show up on 
WorldMap, you can load it to Picasa or YouTube, provide locations using the Picasa or YouTube 
location tools or, if you have it, key in an accurate lat/long.  Then give your content one or more 
unique tags.  Now when you user these keywords as your filter you will only bring in content you 
have uploaded. 
 
6.4 Jump Tool 
WorldMap supports “Jumping” to remote web sites using the geographic extent displayed in the 
current map view to define the view for the site being jumped to.  
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Current Jump sites include Bing Maps (useful for its oblique aerial photography in many major 
cities), Yelp (useful for detailed information on businesses and ratings), and Social Explorer (current 
and historic census mapping).   
 
For example if one were looking at the Englewood neighborhood of Chicago in WorldMap and 
selected “Social Explorer” from the “Jump to” pulldown, a new tab will open displaying a Social 
Explorer interactive census map for the Englewood neighborhood.  Social Explorer now also works 
for China.  
 
From Sierra Leone, try Bing Map.  Now let’s zoom to Chicago and see how this works for Social 
Explorer in the US.   
 
6.5 Downloads 
Maps may be downloaded in a number of file formats including: ESRI Shapefile, Google Earth 
KML, Adobe PDF, Microsoft Excel, CSV (comma delimited text), GML (geographic markup 
language), PNG (image), JPEG (image).  
 
6.6 View in Google Earth 
Layers can be viewed in Google Earth.  Google Earth versions are in the downloads section. 
 
6.7 Printing 
Select the “Open Street Map” base layer and click on the “Print” button at the upper left.  Choose: 

• Portrait type 
• Resolution 
• Whether you want a legend  
• Pan your map in print view if necessary  
• Provide a title for your printout. 

 
Click “Print” and generate a PDF which you can save, email, or print. 
 
NOTE: Printing is supported at up to 300dpi and creates an Adobe PDF view of your map at 8.5” x 
11” (216mm x 279mm) and 8.5” x 11” (216mm x 356mm) sizes. 
 
 

7.0 Exercises for “Getting Information In and Out” Section 
 

1. Within your map add a web service layer.  Go to Add Layers -> External Data -> Add WMS 
Server paste a URL into the form with no spaces at the end.  See list at the bottom of this 
page for valid URLs to use.  Here is the WHO URL: 
http://apps.who.int/tools/geoserver/wfs?request=GetCapabilities?SERVICE=WMS&REQUE
ST=GetCapabilities 

2. A list will be returned.  Sort it by clicking on the Title bar.  Select Global Health Facilities 
then “Add Layers”.  

3. Reorder layer display by dragging a layer above another layer so that it displays on top of the 
other layers. 

4. Change transparency of the layer on top.  
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5. Change the name of a layer.  Change the name of a folder.  
6. Create an embed link and add it to a blog.  If you don’t have a blog, create one using 

Google’s Blogger.  Pan and zoom around your embedded map.   Click “Link”. 
7. View your layer in Google Earth.  Right-click on layer -> Layer Properties -> About -> Share 

Layer.  Then under Downloads click “KML”.  
8. From a view from a neighborhood in a major city in the U.S, use the Jump tool to explore 

contents in Social Explorer, Bing, and Yelp. 
9. Turn on Picasa.  Zoom in.  This is what you see by filtering on keyword “sierra”. Play with 

other keywords like “freetown” or “africa” or “landscape”.  
10. Turn off Picasa, turn on YouTube.  
11. Print your map at 300 dpi with a title and legend. 

 
Optional Challenge Exercise - Creating an SLD using Open Source AtlasStyler 
 

1) Install the application: http://en.geopublishing.org/AtlasStyler. 
2) Create a style for the workshop_suitability.shp shapefile in your packet.  Click “File” then 

“Import File” then choose the file from your desktop.  Click “Finish”. 
3) Right click on the Layer on the left and choose “Style”.  For symbology choose “Colored 

Quantities”.  Choose for your Value, “Cassava S1”.  Choose 4 classes.   
4) Save out your style by clicking “Export All Layers as SLD” and put name the file 

Cassava_test.sld, save it in your folder where you have your shapefile under 
Desktop/WorldMap-Workshop-Materials. 

5) If you create your SLD with AtlasStyler, you will need to make two changes to the 
formatting of the SLD document you create as follows:  
 
Near top of SLD output file created, replace this:  

 
<sld:StyledLayerDescriptor version="1.0.0"  
xmlns:sld="http://www.opengis.net/sld" <http://www.opengis.net/sld>  
xmlns:ogc="http://www.opengis.net/ogc" <http://www.opengis.net/ogc> xmlns:xlink="http://www.w3.org/1999/xlink" 
<http://www.w3.org/1999/xlink>>  
<sld:NamedLayer>  
<sld:Name>SHAPEFILE_NAME</sld:Name>  
<sld:UserStyle>  
<sld:Name>Style1</sld:Name>  
<sld:FeatureTypeStyle> 
<sld:FeatureTypeName>SHAPEFILE_NAME</sld:FeatureTypeName>  
 
with this:  
 
<sld:UserStyle xmlns="http://www.opengis.net/sld"  
xmlns:sld="http://www.opengis.net/sld"  
xmlns:ogc="http://www.opengis.net/ogc"  
xmlns:gml="http://www.opengis.net/gml"> 
<sld:FeatureTypeStyle>   
<sld:Name>ANY_NAME</sld:Name> 
<sld:Title>ANY_NAME</sld:Title> 
 
and delete this from the bottom of the document:  
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</sld:NamedLayer>  
</sld:StyledLayerDescriptor> 
 

6) Upload the workshop suitability shape file along with the SLD you created.  Give your file a 
new title following the convention <subject>_<initials>_temp. 

 
 
8.0 Questions, general help 
 
9.0 Appendices  
 
9.1 Web Map Services that work in WorldMap 
MassGIS – Massachusetts GIS 
http://giswebservices.massgis.state.ma.us/geoserver/wms   
 
New York Public Library Map Rectifier (cached) 
Example: http://maps.nypl.org/warper/maps/tile/11032/z/x/y.png 
Thousands of other cached maps can be found and added to WorldMap by searching NYPL Site 
http://maps.nypl.org/warper/ 
Go to the rectified map you want, click Edit/Rectify, Select Export Tab, copy “Tiles base URL” to 
WorldMap 
 
National Map Program (NAIP) 
http://isse.cr.usgs.gov/ArcGIS/services/Combined/USGS_EDC_Ortho_NAIP/MapServer/WMSServ
er?request=GetCapabilities&service=WMS  
 
Haiti Relief Map 
http://maps.nypl.org/relief/maps/wms/32?request=GetCapabilities&version=1.1 
 
Cubewerx 
http://demo.cubewerx.com/demo/cubeserv/cubeserv.cgi?SERVICE=wms&VERSION=1.1.0&REQ
UEST=GetCapabilities 
 
NEXRAD Weather 
http://mesonet.agron.iastate.edu/cgi-bin/wms/nexrad/n0r.cgi 
 
Human Journey 
http://geoserver.thehumanjourney.net/geoserver/wms?request=getCapabilities?SERVICE=WMS&R
EQUEST=GetCapabilities 
 
World Health Organization 
http://apps.who.int/tools/geoserver/wfs?request=GetCapabilities?SERVICE=WMS&REQUEST=Ge
tCapabilities 
http://apps.who.int/tools/geoserver/wms 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Argentina National GIS  
http://sig.gov.ar/geoserver/ows?service=WMS&request=GetCapabilities 
 
Australia’s Tropical Land and Seas 
http://e-
atlas.org.au/geoserver/wms?service=wms&request=GetCapabilities?SERVICE=WMS&REQUEST
=GetCapabilities 
 
DARMC WMS 
http://cga6.cga.harvard.edu:8081/arcgis/services/DARMC/RE_Provinces_117/Map 
 
DARMC REST 
http://cga6.cga.harvard.edu:8081/arcgis/rest/services/DARMC/CF_Crusader/MapServer  
 
http://sampleserver1.arcgisonline.com/ArcGIS/rest/services/Specialty/ESRI_StatesCiti
esRivers_USA/MapServer  
 
Harvard AfricaMap Server (cached).   
These layers are not well named or documented yet (we are working on that), but there are many 
valuable layers here you won’t find anywhere else. 
http://worldmap.harvard.edu/africamap/tilecache/tiles.py/1.0.0/ 
 

9.2 Software 
Open Source - AtlasStyler 
http://en.geopublishing.org/AtlasStyler 
 
Open Source Desktop GIS - QGIS 
http://www.qgis.org/  
 
Open Source Georeferencing platform - MapWarper 
https://github.com/timwaters/mapwarper  


